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1 CommsGenius Description and Function Summary 

The CommsGenius is an accessory module located inside a SENS EnerGenius IQ battery charger. 
The two primary functions are data communications and synchronizing of the operating modes of two 
digitally controlled IQ chargers including forced load sharing.  Including the CommsGenius in an 
EnerGenius IQ battery charger provides the ability to monitor and/or configure the battery charger 
remotely using either serial or Ethernet connections.   
 
Figure 1:  CommsGenius System Diagram 

 
 
 
The CommsGenius is installed at the factory or can be added to IQ chargers in the field.  Contact your 
charger supplier or SENS to determine if your charger qualifies as CommsGenius ready. 

 
1.1 Data Communications Function 

CommsGenius enables two modes of communication with the IQ charger:  remote via Modbus 
or local via the USB maintenance port.  Each communication method allows the user to adjust 
charger operating modes, view system settings, and adjust system settings.  
 

1.1.1 USB Maintenance Port – Local Communication 
The USB maintenance port enables users to configure an IQ charger from a PC-based 
program called SENS IQ & CommsGenius Setup Utility. SENS IQ & CommsGenius Setup 

REMOTE Charger 

LOCAL Charger 
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Utility also enables fast and accurate execution of settings stored ahead of time, as might 
be required to accurately change a fleet of chargers. 
 
This manual describes operation over the USB maintenance port in detail using the SENS 
IQ & CommsGenius Setup Utility. With a few exceptions noted in the Modbus section all 
information and commands available via the USB maintenance port are available over 
Modbus.  Operation of the Modbus master HMI (Human Machine Interface) is outside 
the scope of this manual. 
 

1.1.2 Modbus Network – Remote Communication  
If the remote communications processor daughter board was ordered, Modbus data 
communications will be available over either RS-485 (pluggable terminal block) or 
10Base-T TCP/IP Ethernet (RJ-45 connector).  Each of these ports is user configurable in 
the SENS IQ & CommsGenius Setup Utility program. The communications processor 
daughter board is installed at the factory or it can be added in the field to an existing 
CommsGenius.  The SENS IQ & CommsGenius Setup Utility program is used to initially 
configure Modbus settings. 

 
1.2 Dual IQ Charger Synchronizing and Load Share Functions 

The CommsGenius provides a central point of communication with both chargers of a 
redundant charger system, and ensures that chargers behave in an identical manner. This 
enables: 

• A common source of battery temperature data for charge voltage temperature 
compensation ("remote temperature sense") 

• Forced load sharing 
• Harmonized operation of chargers while in modes other than float charge, such as 

equalize charge or battery check  
 

Only one IQ charger in a two charger redundant system requires a CommsGenius accessory 
module for charger synchronization and load sharing. 

    
1.3 CommsGenius On-Board Battery 

The CommsGenius includes an on-board coin cell battery to ensure data and time retention 
regardless of charger operation.  Use Modbus address 0x0001 to determine if the battery needs 
to be replaced.  This battery type is identical to that typically supplied in PCs to support the 
real time clock.   
 
Note:  Battery contains Perchlorate material – special handling may apply.  See 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 

 
The battery may be replaced by trained service personnel only.  Disconnect both AC and DC 
power sources before attempting to service the battery.  Replace the battery with only a lithium 
CR2032 rated for use at 70°C or higher.  

 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate�
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2 Initial Hardware Setup   
 

2.1. Setup CommsGenius Network Connections 
Connect hardware as described and shown below.  See Section 3 for instructions on configuring 
hardware connections using SENS IQ & CommsGenius Setup Utility software.  See Appendix C 
for System Diagram. 
 

Figure 2:  CommsGenius Connections Summary (customer connections indicated in bold) 

 
 

2.1.1. RS-485 Connection Requirements 
The RS-485 network cabling shall be installed as described in Modbus over serial line 
specification and implementation guide V1.02, published by Modbus-IDA 
(http://www.Modbus-IDA.org). 
 

CommsGenius DC 
power input 

CommsGenius connection 
to LOCAL IQ Charger 

Remote Temperature 
Sensor Port (optional) 

USB Communication  
Port (top of charger) 

RS-485 Modbus 
Communication 

Port 
 

10Base-T TCP/IP 
Ethernet Modbus 

Communication Port 

REMOTE IQ Charger 
Load Share Port 

http://www.modbus-ida.org/�
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Figure 3:  RS-485 Connection Diagram 

 
 
Pay special attention to these requirements: 

• Bus loading shall be not more than 32 devices on a bus, unless RS-485 repeaters 
break the bus into segments with no more than 32 device loads each. The bus 
master and bus repeater(s) count against the 32-device limit (See Physical Layer - 
Multipoint System requirements section in Modbus-IDA specification). 

• Maximum bus length not to exceed 1000m (3000 ft) at 9600 Baud, reduced 
appropriately for faster data rates (See Physical Layer - Multipoint System 
requirements section in Modbus-IDA specification) 

• Stubs ("derivation cables") shall not exceed 40m (120 ft) total for all passive taps 
attached to the bus, and not more than 20m (60 ft) at any one tap (See Physical 
Layer - Multipoint System requirements section in Modbus-IDA specification) 

• Longer stubs require the use of "active taps" (See Physical Layer - Electrical 
Interfaces section in Modbus-IDA specification) 

• The "COM" line (signal reference) must be connected to all devices on the bus. 
COM shall be tied to chassis ("earth", "protective ground") at exactly one point, 
preferably at the bus master (See Physical Layer - Multipoint System 
requirements section in Modbus-IDA specification) 

• Cable terminations are applied only at the ends of the bus (See Physical Layer - 
Multipoint System requirements section in Modbus-IDA specification) 

• SENS IQ and CommsGenius do not require bus polarization (See Physical Layer 
- Multipoint System requirements section in Modbus-IDA specification) 

• Cables must have shielded twisted pair construction, with nominal impedance 
between 100Ω and 150Ω (See Physical Layer – Cables section in Modbus-IDA 
specification) 

• Cables must be rated for use at 70°C or higher. 
• Cable enters the charger at the opening at the top left side of the chassis. Keep 

signal cables away from the AC and DC power wiring! 
• Attach the RS-485 cable to the four-position connector provided with the 

CommsGenius communications board. COM is pin 1 (left), +D1 (A) is pin 2, -
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D0 (B) is pin 3, and protective ground (chassis) is pin 4 (right).  See Modbus-
IDA specification for further connection definitions and explanation.  

 

Figure 4:  RS-485 Connector 

 
 

• The common (signal reference) line may either be connected using the cable 
shield (all devices connect COM to the shield, only MASTER connects shield to 
protective ground), or connected using a third wire in the shielded cable (all 
devices connect COM to the third wire, all devices connect the shield to 
protective ground, only MASTER connects COM to protective ground). SENS 
products are compatible with either convention for shield connections, provided 
use of the cable shield is consistent throughout the RS-485 bus. Mixing shield 
connection conventions within the same bus is not acceptable; this causes 
increased system noise and data errors. 

 
2.1.2. Troubleshooting Common RS-485 Problems  

• Data rate too fast for the bus cable in use. Lower quality cables have higher 
signal loss, reducing the maximum possible length. 

• Incorrect baud rate settings in one or more devices 
• Incorrect parity and stop-bit settings in one or more devices 
• Data cables exposed to excessive noise and transients. Route data cables as far 

away from power conductors as practical. Data cables run outdoors or for long 
distances (more than 10m between bus devices) should be equipped with 
appropriate transient protection devices. 

• Reversed polarity on one or more devices. All -D0 (B) signals must be on the 
same wire, all +D1 (A) signals must be on the same wire, and all COM signals 
must be on the same wire. 

• Missing COM connection on one or more devices 
• Improper termination: termination must be applied only at the ends of the bus, the 

inputs and outputs of RS-485 repeaters, and at both ends of active bus tap cables. 
Termination must not be enabled for devices inside the bus, including devices on 
passive taps (stubs). 

• Connecting COM to protective ground at more than one point. This connection 
shall be made at one point, and only one point, preferably at the bus master. 

• Shields connected at only one end. "Ground loop" currents should be avoided by 
connecting the shield to either COM or CHASSIS in all slave devices, taps, and 

RS-485 connection
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repeaters. The only place where the shield may connect to both circuits is the 
single-point ground (at the bus master). If the shield is connected to CHASSIS in 
all slave devices, then a separate conductor for COM must be provided in the 
shielded cable. 

 
2.1.3. 10Base-T TCP/IP Ethernet Connection Requirements  

The 10Base-T TCP/IP Ethernet connection is a standard 10-Base-T or 100-Base-T 
connection.  Connect to the RJ-45 connector using a Cat5 or better cable.  
WARNING:  The 10Base-T TCP/IP Ethernet connection is not for telephone use.  High 
ringing voltages on telephone wiring may damage the network card. 
 

Figure 5:  10Base-T TCP/IP Ethernet Connection Diagram 

 
 

Figure 6:  10Base-T TCP/IP Ethernet Connection 

 
 

2.2. Setup  Dual IQ Charger Synchronizing and Load Share 
 

2.2.1. REMOTE Charger Data Port Connection Requirements 

10Base-T TCP/IP 
Ethernet connection 
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Use the provided REMOTE Charger Data cable to connect the REMOTE charger for 
dual charger systems.  The cable enters both chargers at the opening at the top left side of 
the chassis.  Keep signal cables away from the AC and DC power wiring! 
 

Figure 7:  Load Share Connection Diagram 

 
 

2.2.1.1. Connection at the CommsGenius   
•  Attach the sensor wires to the three-position connector provided with the 

CommsGenius communications board. Be sure the wire order in the connector 
(shield at top, then red, then black) is correct per the orientation shown in 
Figure 1 (wires on left, with screws facing the installer). 

 

Figure 8:  REMOTE Charger Data Cable Connection at CommsGenius 

 
 

•  The three-position connector (with wires attached) then attaches to the 
REMOTE Charger Port on the CommsGenius.  
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Figure 9:  REMOTE Charger Port 

 
 

•  Use the cable clips on the CommsGenius bracket to support the cable and 
connector.   

 
2.2.1.2. Connection at the REMOTE Charger 

•  The other end of the cable attaches to the upper terminal block (TB2) on the 
control board of the second charger. 

•  Route the wiring through the cable clip at the upper right corner of the 
charger's control board. This relieves stress at the terminal connections. 

•  Avoid excess slack in the wiring. Excess wire should be neatly bundled and 
tied near the cable entrance, so it cannot contact any live or hot parts. 

•  Connect the cable shield to terminal #1 (SHIELD), the red wire to terminal #2 
(+LOOP), and the black wire to terminal #3 (-LOOP). 

 

Figure 10:  REMOTE Charger Data Cable Connection at REMOTE Charger 

 
 

REMOTE Charger Port 

Connection at REMOTE 
Charger 
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•  Route the wiring through the cable clips behind and under the top door frame 
of the second charger. This holds the wiring away from hot and live parts 
inside the charger, and prevents pinching the cable when the door is closed. 

 

Figure 11:  REMOTE Charger Data Cable Routing 

 
 

2.2.2. Troubleshooting Common REMOTE Charger Data Port Problems 
• Reversed polarity at the charger control board (verify wiring by color code). 
• Connecting to the wrong terminal block on the charger control board. The lower 

terminal block (TB3) is for the summary alarm relay, not the data port cable. 
• Connecting the three-pin data port connector to the four-pin RS-485 socket on the 

CommsGenius communications board. 
 

2.3. Setup Remote Temperature Sensor 
 

Figure 12:  Remote Temperature Sensor Connection Diagram 

 
 

2.3.1. Remote Temperature Sensor Connection Requirements 
• Use the provided temperature sensor and cable. 
• Locate the sensor where it will be exposed to the same temperature as the batteries 

being charged, but not directly attached to hazardous live parts.  See the “How to 
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Install a Remote Temperature Sensor” insert provided with the remote temperature 
sensor kit for detailed instructions on sensor placement. 

• Attach the sensor to the two-position connector provided with the CommsGenius 
communications board. The temperature sensor is not polarity-sensitive. 

• Cables enters the charger at the opening at the top left side of the chassis. Keep signal 
cables away from the AC and DC power wiring! 

• The two-position connector attaches to the mating socket on the CommsGenius 
communications board. Use the cable clips on the CommsGenius communications 
board bracket to support the cable and connector. 
 

Figure 13:  Remote Temperature Sensor Socket and Cable Clips 

 
 

2.3.2. Troubleshooting Common Remote Temperature Sensor Problems 
• Connecting the two-pin temperature sensor connector to the three-pin data port 

connector or to the four-pin RS-485 socket on the CommsGenius communications 
board. 

• Temperature sensor installed where air temperature differs from battery temperature, 
such as close to heat-producing equipment.  Affix the sensor to the battery as 
specified is Section 6.  

 

Remote Temperature 
Sensor Socket 

Cable Clip 

Cable Clip 
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3 Initial Setup to Communicate With Charger From PC Via USB Port 
 

3.1. PC System Requirements 
Setting up a CommsGenius requires a PC.  The CommsGenius does not include DIP switches 
or any other means of manual configuration. 
 

Figure 14:  USB Connection Diagram 

 
 
• CPU: 32-bit 600 Mhz minimum, 1 Ghz recommended  
• Operating system: Microsoft Windows 2000® acceptable, Windows XP® or Vista® 

recommended 
• System RAM: 512 MB minimum, 1 GB recommended 
• Disk space: 285 MB 
• Display resolution: 1024 x 768 minimum, 1280 x 1024 recommended 
• USB 2.0 host port capable of full power operation (500mA), cable up to 4.5m (15 feet) 

long, standard size type "B" connector.  A 2m (6 foot) cable is included with charger. 
 

3.2. Connect to USB Maintenance Port 
Connect the USB maintenance port to the PC via a USB 2.0 interface. The USB cable must 
have a standard size "type B" plug for the maintenance port, and may be up to 4.5m (15 feet) 
long.  The USB cable should not be extended beyond this length.  The IQ charger USB 
maintenance port is a "plug-and-play" USB serial port that requires a driver to be installed 
on the PC before it can be used.  Install the driver by following the instructions in 
Section 3.3 or the README file provided on the accompanying software CD.  Detailed 
instructions on driver installation are provided at 
http://www.ftdichip.com/Documents/InstallGuides.htm.  To view instructions, select the 
Installation Guide appropriate for your PC operating system. 

  

 

http://www.ftdichip.com/Documents/InstallGuides.htm�
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Figure 15:  USB Port 

 
 
The communications board will be powered-on and operate whenever it is connected to a USB 
host, whether or not the charger is operating. This permits using the maintenance port to 
configure communications settings before the final charger installation. However, it is not 
possible to communicate with the charger via the CommsGenius or to adjust any charger 
settings unless the charger is operating from an AC or DC power source. 
 
USB version 2.0 is required for proper operation.  See the following steps to determine if the 
connected PC has version 2.0: 

• Navigate as follows: 
¾ Right-click My Computer  
¾ Click on Properties  
¾ Click on the Hardware tab  
¾ Click on the Device Manager button  
¾ Scroll down as needed until you see Universal Serial Bus Controllers  
¾ Expand that by clicking on the boxed plus sign in front of Universal Serial 

Bus Controllers 

• View similar to following: 
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• Note the highlighted line: "Standard Enhanced PCI to USB Host Controller". While 

the exact text may vary, the presence of the word "Enhanced" indicates USB 2.0.  If 
“Enhanced” is not included, the port is USB 1.x only.  Note that even with the word 
"Enhanced" some machines may have a mixture of 1.1 and 2.0 ports.  Consult the PC 
Manual to confirm which ports are 1.1 and 2.0. 

  
3.3. Install SENS IQ & CommsGenius Setup Utility Software on Local PC and Verify Operation 
 

3.3.1. Install software  

IMPORTANT:  These steps MUST be completed in order from 1 to 6 

• Uninstall any previous installations of the SENS IQ & CommsGenius Setup Utility 
using Microsoft "Add or Remove Programs" on the Control Panel 

• Insert the software installation CD provided with the CommsGenius accessory 
module and open browser window to view CD files 

• Install the USB driver provided by double-clicking on the FTDI USB DRIVER AUTO 
Install (CDM 2.04.16).exe file  
Note:  A DOS window will appear with “Installing driver…”, if the window exits 
with no errors, the installation was successful 

• Connect the USB cable to the PC (USB Version 2.0 only) and to the charger (left-
side of the top cover) 
Note:  Windows will communicate “Found New Hardware”; wait until you see 
“Your new hardware is installed and ready to use” 

• Install the Microsoft .NET Framework Version 2.0 provided by double-clicking on 
the dotnetfx.exe file.  Follow instructions to complete setup.   
Note:  If a .NET compatibility error occurs, you have a newer version of .NET and 
can still proceed   

• Install the SENS IQ & CommsGenius Setup Utility by double-clicking the SENS IQ & 
CommsGenius Setup Utility.msi file.  Follow instructions to complete setup.   

 
3.3.2. Verify Operation 

Open the SENS IQ & CommsGenius Setup Utility by selecting SENS IQ & CommsGenius 
Setup Utility under the SENS folder found via the PC Start menu. 
 
Once open, select the desired mode or choose to update CommsGenius firmware under 
the Options pull-down menu as shown below.  
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Figure 16:  Select Software Connection Mode 

 
• On-Line Mode – normal operating mode used to view and adjust connected 

CommsGenius settings. 
Note:  While in On-line mode, if the USB cable is disconnected and a read is 
attempted in the SENS IQ & CommsGenius Setup Utility, a fatal error will be 
displayed and the utility will close. 

• Off-Line Mode – use when not connected to a CommsGenius or when values are to 
be saved to a file and not to the charger via the CommsGenius.  Adjust and save 
values to a file for future upload to a CommsGenius. 

• Update CommsGenius Firmware - select to update CommsGenius firmware.  Once 
selected, open the appropriate .scg firmware file and wait for firmware update to 
complete.  The status at the bottom of the window will show "Firmware 
Update Successful" when the update has completed properly.   
Note:  .scg firmware files should not be confused with .cgs data files created using 
the SENS IQ & CommsGenius Setup Utility 

 
Next, select the serial port used to connect the PC to the CommsGenius from the drop-
down selection under Step 1.  If it is unclear which Comm Port to select, see the 
following instructions to determine the proper Comm Port: 
• Plug in the USB cable prior to opening the SENS IQ & CommsGenius Setup Utility 
• View the Comm Port options in the drop-down selection 
• Disconnect the USB cable and refresh the software program.  The Comm Port no 

longer present is the correct selection. 
• Reconnect the USB cable and refresh to make the correct selection. 
 
Press the Connect button under Step 2 to connect the SENS IQ & CommsGenius Setup 
Utility to the CommsGenius, or to fully open the software when in Off-Line Mode.   
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Figure 17:  Connect Software to CommsGenius 

 
 

Upon successful connection, the software will open and display a quick start guide as 
well as a blank window with menu options as shown below.  See Section 4 for software 
instructions and details. 

Figure 18:  Main Software Window 
 

 
 
 

3.3.3. Troubleshooting USB and CommsGenius Communication   
If the SENS IQ & CommsGenius Setup Utility will not connect with the CommsGenius: 

• Ensure the proper Comm Port is selected.  See previous section for instructions on 
Comm Port selection.  

• Verify the USB cable is properly connected to the PC and IQ charger  
• Verify the CommsGenius is powered on and connected to the IQ charger.  When 

connected, the LED on the CommsGenius board will be lighted.  This LED will also 
blink upon clicking the "Connect" button on the Getting Started window. 
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Figure 19:  CommsGenius Board LED 

 
 

 
 
4 USB Maintenance Port Operation using SENS IQ & CommsGenius Setup Utility 
  

The USB maintenance port enables users to configure an IQ charger using the PC-based SENS IQ & 
CommsGenius Setup Utility (see previous sections for hardware and software installation 
instructions).  With a few exceptions, all functions available via the IQ charger front panel display 
are available using the SENS IQ & CommsGenius Setup Utility software. 
 

  
 

Note:  While in On-line mode, if the USB cable is disconnected and a read is attempted in the SENS 
IQ & CommsGenius Setup Utility, a fatal error will be displayed and the utility will close. 

 

4.1 SENS IQ & CommsGenius Setup Utility Software Summary  
The SENS IQ & CommsGenius Setup Utility is arranged in windows that generally correlate to 
the charger’s front panel menu selections, as shown in the table below: 
 
Task Charger Front 

Panel 
SENS IQ & CommsGenius Setup 
Utility Window on PC (accessed 
via View menu) 

Read meters Read front panel 
LCD 

Meters  

Adjust charger operating modes Charge mode key Operating Mode  
View/adjust equalize settings Equalize settings 

menu 
System Equalize  

View/adjust charger output 
settings 

Output settings 
menu 

System Output 

View alarm status Front panel LED, 
LCD 

Alarm Status 

Adjust alarm settings Alarm settings 
menu 

Alarm Status  

Perform manual battery check Battery check key Operating Mode 

IMPORTANT: Plugging a USB cable into the charger’s USB maintenance port 
interrupts network communications. If your system is in active network use make 
sure you alert your network operator that you will be taking the charger offline by 
using USB communications. Network communications is automatically restored 
when you remove the USB cable from the charger’s USB port.  
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Adjust battery check settings Battery check 
menu 

Battery Check  

Adjust temperature 
compensation settings 

Unit setup menu Temp Comp System  

View charger configuration  View unit info 
menu 

Charger Configuration 

Adjust number of battery cells Unit setup menu Charger Configuration 
 

4.2 SENS IQ & CommsGenius Setup Utility Software Operations 
Note:  The settings described below are limited by the charger’s control laws, and are 
explained in the EnerGenius IQ user manual. In redundant charger systems the settings made 
are automatically applied to both chargers, and override existing settings. 
 

4.2.1 File Menu 
    Access file and save options by selecting the File pull-down menu.    
 

4.2.1.1 Open Settings File… 
Load/populate the SENS IQ & CommsGenius Setup Utility with settings from a file 
stored on the PC. 
 

4.2.1.2 Open Charger(s) Settings via CommsGenius  
Load/ populate the SENS IQ & CommsGenius Setup Utility with settings stored on 
the CommsGenius and its host IQ charger. 

 
4.2.1.3 Save Settings File 

Save settings displayed in the SENS IQ & CommsGenius Setup Utility to a file for 
later use.  Saved CommsGenius Settings Files will have a .cgs extension. 
Note:  .cgs files created using the SENS IQ & CommsGenius Setup Utility should not 
be confused with .scg CommsGenius firmware files 
 

4.2.1.4 Save Settings File As… 
Save settings (select save directory) displayed in the SENS IQ & CommsGenius Setup 
Utility to a file for later use.  Saved CommsGenius Settings Files will have a .cgs 
extension. 
Note:  .cgs files created using the SENS IQ & CommsGenius Setup Utility should not 
be confused with .scg CommsGenius firmware files 

 
4.2.1.5 Save Settings to Charger(s) via CommsGenius 

Execute settings made and displayed in the SENS IQ & CommsGenius Setup Utility 
to the CommsGenius.  
IMPORTANT:  No settings changes made to the SENS IQ & CommsGenius Setup 
Utility are written to the CommsGenius or host IQ charger until this menu selection 
is made.  
 
There is no “undo” command other than restoring factory defaults, so double-check 
values before saving settings to charger. 

 
4.2.1.6 Revert to SENS Default Settings 

Load/populate the SENS IQ & CommsGenius Setup Utility with SENS factory default 
charger settings when in Off-line mode only (feature not active in On-line mode).  
Select appropriate battery type to ensure proper settings. 
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4.2.1.7 Exit 

Exit the SENS IQ & CommsGenius Setup Utility. 
 

4.2.2 View Menu 
Access each window of the SENS IQ & CommsGenius Setup Utility by selecting it from 
the View pull-down menu. Each window remains active in the program as long as it 
remains selected in the View menu. A check mark by each option in the menu list 
indicates the window is displayed.  Remove a window by deselecting it from the View 
menu or closing the window.  The window arrangement is automatically saved upon exit. 

 
Figure 20:  Example Software Active Windows 

 
 

4.2.2.1 Read Only Settings 
Open windows to view charger settings.  No adjustments are allowed to these 
settings. 

 
4.2.2.1.1 Meters 

View charger voltage, amperes, temperature and elapsed operation time.  
Note:  Elapsed Operation months in the Meters window are 4week/28day 
months. 

 
4.2.2.1.2 Charger Configuration 

View model number, serial number, build date, battery cell count, and battery 
cell chemistry. 
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4.2.2.2 Real Time Controls 
Open a window to adjust charger controls in real-time.  In contrast to all other 
windows, any changes requested from this window are immediately executed by the 
charger.  No other windows are active while this window is open. You must close the 
Real Time Controls window to make changes to any other menu item. 
 

4.2.2.2.1 Operating Mode 
Set and view Float, Equalize, or Auto output modes, Battery Check mode 
and view Equalize time remaining and time elapsed.  Select the desired mode 
to engage that mode at the charger.  

 
4.2.2.3 Settings 

Open windows containing settings that may be viewed, adjusted, and saved to the 
CommsGenius or a file using the options provided under the File menu.  
 

4.2.2.3.1 System Equalize 
View and adjust equalize operation values. 
 

4.2.2.3.2 System Output 
View and adjust output voltages and current limit operation. 
 

4.2.2.3.3 Alarm Status 
View active alarms, which are indicated by a check mark next to each alarm.  
Also view and adjust alarm settings.  In a redundant charger system the 
CommsGenius forces both chargers’ alarm setpoints to identical values, but 
displays alarm states independently. 
Note:  When there is a communications failure between the IQ charger and 
the CommsGenius, the Charger/CommsGenius Communications Failure 
alarm is the only alarm that will show RED.  The status of the other alarms 
will show GREY and may or may not be valid due to the lack of 
communication with the charger. 
 

4.2.2.3.4 Battery Check 
Enable and configure Battery Check operation.   
 

4.2.2.3.5 Temp Comp System 
Enable and configure Temperature Compensation operation. 
 

4.2.2.3.6 Communication 
Enable and configure the preferred communication method.  By factory 
default, CommsGenius enabled IQ chargers are configurable only via a direct 
USB cable connection.  To enable an alternate network connection method, 
the user must first connect using the USB cable and then select either Serial 
Modbus ASCII, Serial Modbus RTU, or Modbus TCP/IP.  The CommsGenius 
can only connect through one method at a time.  The USB cable connection 
will always take priority and disable other connections.   
 
All connections, except for a direct USB cable, are read-only by factory 
default for security reasons.  See Allow Network Access under the Options 
menu for information on enabling network access. 

 
4.2.2.3.7 Clock    
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View and adjust date and time.  Choose to read time from or save time to the 
connected CommsGenius.  If Use PC System Time (under the Options menu) 
is active, then the Clock window values are ignored and the PC system time 
is used instead. 
Note:  Be sure PC system time matches network time as networks may 
standardize on a time zone different from local time or may not adjust for 
daylight savings time. 

 
4.2.3 Options Menu 

Access options by selecting the Options pull-down menu.  Select each option to activate.  
A check mark by each option in the menu list indicates the feature is active.  Deactivate 
by deselecting each option from the Options menu. 
 

4.2.3.1 Dual Chargers 
View the REMOTE charger of a redundant charger system when the CommsGenius 
is connected to both LOCAL and REMOTE chargers.  LOCAL and REMOTE 
charger values will be displayed together in windows activated using the View pull-
down menu.   
NOTE:  Any changes to this setting will be ignored unless the user executes a 
"Save Settings to Charger(s) via CommsGenius" command.  Even if the Utility 
shows it as enabled, the user must do an "Open Charger(s) Settings via 
CommsGenius" command and check to verify that the setting has been stored. 
 

4.2.3.2 Allow Network Access 
Enable ability to adjust all SENS IQ & CommsGenius Setup Utility settings via 
network communication, rather than only by the USB cable connection.  By enabling 
network access the user assumes all liability with regards to security as described in 
the software end-user license agreement.  
NOTE:  Any changes to this setting will be ignored unless the user executes a 
"Save Settings to Charger(s) via CommsGenius" command.  Even if the Utility 
shows it as enabled, the user must do an "Open Charger(s) Settings via 
CommsGenius" command and check to verify that the setting has been stored. 
 

4.2.3.3 Use PC System Time 
Enable use of PC system time for CommsGenius time.  When active, the PC system 
date and time are automatically used for the CommsGenius and values set in the 
Clock window (under the View menu) are ignored. 

 
4.2.4 Help Menu 

Access help options by selecting the Help pull-down menu.   
 

4.2.4.1 Help File 
View basic help and troubleshooting information. 
 

4.2.4.2 Quick Start Guide 
View Quick Start Guide 
 

4.2.4.3 About 
View SENS IQ & CommsGenius Setup Utility version and basic information. 
  

4.2.4.4 Reset Warnings 
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Re-enable any help/warning/tip boxes that were previously selected to not show 
again. 

 
5 Dual IQ Charger Synchronizing and Load Share Operation 
 

Load Sharing is an optional feature in which two chargers are electrically connected using a 
CommsGenius and the REMOTE Charger Data cable.  Load sharing is intended to force two chargers 
to resolve close differences in output voltage settings to ensure the current load is shared equally.  
Because the two chargers are connected to one set of batteries, load share operation works best if 
accompanied by a Remote Temperature Sensor (see Section 6). 
 
Normally only one IQ charger from a two charger redundant system will include a CommsGenius 
accessory module for charger synchronization and load sharing.  See Section 2 for installation 
instructions.  It is possible, but not recommended, for each of a redundant pair of chargers to use its 
own CommsGenius. When this is the choice, the inter-charger communication feature of the 
CommsGenius cannot be used.  This means that the automatic synchronization of operating values 
and modes will not occur.  Instead of a “redundant charger system” the chargers will operate as fully 
independent chargers.  
 
The IQ charger that physically hosts the CommsGenius accessory module is called the LOCAL 
charger.  The IQ charger connected to the host IQ’s CommsGenius via the REMOTE load share port 
is called the REMOTE charger.  See Appendix C for System Diagram.   
 
5.1. Charger Synchronization 

After some moments, up to a minute, after connecting the REMOTE Charger Data cable to the 
LOCAL charger’s CommsGenius, operation of chargers becomes synchronized in all respects.  
The LOCAL charger hosting the CommsGenius is in control while the REMOTE charger 
mirrors the LOCAL charger’s operation.  The REMOTE charger’s settings are automatically 
set to agree with those of the LOCAL charger.  The front control panel of the REMOTE 
charger becomes inactive.  If the REMOTE charger is equipped with a Form C alarm card, its 
alarms will continue to report status of only the REMOTE charger. The alarm thresholds will 
have changed to become identical to those of the LOCAL charger.   
 

5.2. Load Share Operation 
Once the chargers are connected via the REMOTE Charger Data cable, load sharing will occur 
automatically.  Load sharing can be turned off only by disconnecting the REMOTE Charger 
Data cable. 
 

5.3. Load Share Troubleshooting 

• Load share responds slowly: 1 to 2 minutes initial load sharing pickup response time is 
normal. Load sharing requires the output voltages of the chargers to be very closely 
matched. Load share adjustments occur in very small steps, to ensure the narrow range 
where satisfactory sharing occurs will be found reliably. Once load share is established 
chargers will track each other quickly regardless of step load changes. 

• Uneven load sharing: Up to 10% difference between the chargers is normal. For best 
results, the DC output wiring from each charger to the point of common coupling (load, 
battery, or power distribution center) should be designed for equal voltage drops in each 
charger output cable: equal wire lengths, equal wire gauges, and a symmetrical 
configuration rather than a bus structure. 
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• Unless the chargers have equal temperature sensor readings, temperature compensation 
should be disabled. Best practice is to use the SENS remote temperature sensor accessory 
connected to CommsGenius. Local temperature sensors will work only if both chargers 
have similar air temperatures at their bottom ventilation grilles: side by side installation is 
acceptable, but mounting one charger above the other allows hot air exiting the lower 
charger to pre-heat the air entering the upper unit. That causes significant temperature 
sensing error, which reduces that charger's set point and consumes load share adjustment 
range to correct for the temperature differential. 

• "Positive ground fault" alarm indication: This can occur when a load sharing charger is 
equipped with output blocking diodes (last numeric character in charger model number is 
"3" or "4"), and the charger is disabled (AC failure, etc.) while the DC output circuit 
breaker is closed. The blocking diode disconnects the negative output terminal from the 
charger's ground fault sensing bridge, while the positive output remains connected. This 
asymmetry causes a weak ground fault current to flow in the positive output, which the 
other charger detects, causing a ground fault indication. To avoid this alarm, the ground 
fault sensitivity setting must be LOW or OFF. The ground current is real, and can be 
detected by the more sensitive ground fault thresholds. 

 
6 Remote Temperature Sensor Operation 
 

The Remote Temperature Sensor is located at the batteries and provides battery temperature data to a 
charger so it can appropriately adjust its output voltage depending on temperature (temperature 
compensation).  The Remote Temperature Sensor also provides a common source of battery 
temperature data for temperature compensation of both chargers in a redundant charger system.   
 
Connecting the Remote Temperature Sensor automatically enables remote temperature compensation.  
See Section 2 for installation instructions.  Local (at the IQ charger) temperature compensation is 
default when a CommsGenius is not included.  Use the IQ charger front panel controls to disable both 
local and remote temperature compensation. Remote temperature compensation may also be 
enabled/disabled using the SENS IQ & CommsGenius Setup Utility software.   
 
6.1 Sensor Placement 

The best sensor location is one that best detects temperature of the battery’s electrolyte. Other 
sensor locations can give false readings and cause incorrect battery charging.  

 
Fix the sensor to the battery terminal or case. .Do not damage the battery case or otherwise 
compromise the integrity of the battery case.  

• Ideal connection is to a terminal of the battery jar in the warmest location. This will often be 
the mechanical center of a battery strong. Connect the sensor to the battery terminal using 
readily available hardware, preferably stainless steel to prevent corrosion. 

• Alternatively, fix the sensor to the battery case with a high strength adhesive or other method 
that will not unduly stress the battery case. 

• Locate the sensor near the center of a vertical side of the battery case. 

• Do not place battery atop the sensor. 

• Place the sensor where it will not collide with nearby battery jar(s) or rack even with worst-
case swelling of battery case or movement of battery and rack, as might be expected during 
earthquake or other mechanical shock. 
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6.2 Electrical and Wiring Considerations 
One or two IQ chargers connected to a CommsGenius can use an electrically isolated remote 
sensor attached to TB15 of the CommsGenius. The sensor is suitable for air temperature sensing, 
surface sensing, and for attachment to a battery terminal.  The sensor is not polarized.  For 
battery terminal sensing, SENS recommends attaching the CommsGenius remote temperature 
sensor to the terminal attached to the grounded conductor of the battery system. The sensor 
circuit operates at the same low voltage as the data communications circuits (5Vdc) regardless of 
the chargers' DC output rating. The sensor circuit is current and power limited, meeting Code 
requirements for a Class 2 circuit. 

 
See the EnerGenius IQ charger manual for further temperature compensation information. 

 
7 Modbus Network Communications Operation  
 

Modbus data communications will be available when the optional remote communications processor 
daughter board is included in an IQ charger.   
 
Modbus is an application layer messaging protocol used for client/server communication and was 
implemented according to Modbus Application Protocol Specification V1.1b and Modbus over serial 
line specification and implementation guide V1.02 provided by Modbus-IDA (http://www.Modbus-
IDA.org).   
Modbus is a registered trademark of Schneider Automation Inc. 
SENS and EnerGenius are registered trademarks of Stored Energy Systems LLC. 

 
The user may select to use Modbus over either RS-485 (detachable terminal block) or 10Base-T 
TCP/IP Ethernet (RJ-45 connector).    Two modes of operation exist for Modbus over RS-485:  
Modbus ASCII or Modbus RTU.   
 
Most functions are available over the network. However, network access must first be enabled 
through the USB Maintenance Port using the SENS IQ & CommsGenius Setup Utility software. The 
Network Access flag is available under the Internal Control pull-down menu. The following functions 
are never available over the network: 

• Change number of cells in battery 
• Change Cell Chemistry 

 
7.1 Boolean Status (Binary Inputs), Modbus Function 0x02  

 
Access  

Address Name Description 
USB Network 

Internal STATUS (Addressed as BITS, read 8 bits per BYTE, lowest address is LSB of first byte) 

0x0000 Nonvolatile Memory 
Read Error 

On indicates error encountered when reading on-board 
nonvolatile memory 

0x0001 On-Board Battery Low On indicates on-board battery voltage is low. 

0x0002 Remote Temp Sensor 
Error 

When true remote temperature sensor reading is in 
error. 

R R 

0x0003 Remote Temp Sensor 
Short When true indicates Temp sensor error is a short   

0x0004 Remote Temp Sensor 
Open When true indicates Temp sensor error is an open   

http://www.modbus-ida.org/�
http://www.modbus-ida.org/�
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Access  
Address Name Description 

USB Network 

0x0005 Charger1 Comm Fail 
True = CommsGenius has lost communications 
with Charger1. False = Communications with 
Charger1 are normal. 

R R 

0x0006 Charger2 Comm Fail 
True = CommsGenius has lost communications 
with Charger2. False = Communications with 
Charger2 are normal. 

R R 

CHARGER 1 STATUS (Addressed as BITS, read 8 bits per BYTE, lowest address is LSB of first byte) 

0x0100 Summary Alarm R R 

0x0101 Charger Fail Alarm R R 

0x0102 AC Fail Alarm R R 

0x0103 High DC Voltage 
Alarm 

R R 

0x0104 Ground Fault Alarm R R 

0x0105 Battery Fault Alarm R R 

0x0106 Low DC Voltage 
Alarm 

R R 

0x0107 End Discharge Limit 
Alarm 

Alarm status: On = Alarm, Off = OK 
 

R R 

0x0108 Equalize Charge Equalize charge active (for any reason) R R 

0x0109 Current Limit Output at maximum current R R 

0x010A Thermal Limit Thermal protection active R R 

0x010B DC Breaker Open DC breaker open R R 

0x010C Reverse Polarity Reverse polarity at output R R 

0x010D Positive Ground Positive ground fault R R 

0x010E Negative Ground Negative ground fault R R 

0x010F Battery Discharge Voltage below discharge threshold R R 

0x0110 Redundancy Check Charger will not support system load R R 

0x0111 OverVoltage 
Shutdown 

True = an over voltage condition has caused charger 
to shut down 

R R 

0x0112 Low Output Current True = Output current is below low current alarm 
setting 

R R 

0x0113 Battery Overtemp True = Temperature sensor indicates battery is over 
temp 

R R 

0x0114 Temp Sensor Fail True = Temperature sensor reading out of range. R R 

CHARGER 2 STATUS (Addressed as BITS, read 8 bites per BYTE, lowest address is LSB of first byte) 

0x0200 Summary Alarm R R 

0x0201 Charger Fail Alarm R R 

0x0202 AC Fail Alarm R R 

0x0203 High DC Voltage 
Alarm 

R R 

0x0204 Ground Fault Alarm 

Alarm status: On = Alarm, Off = OK 
 

R R 
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Access  
Address Name Description 

USB Network 

0x0205 Battery Fault Alarm R R 

0x0206 Low DC Voltage 
Alarm 

R R 

0x0207 End Discharge Limit 
Alarm 

 

R R 

0x0208 Equalize Charge Equalize charge active (for any reason) R R 

0x0209 Current Limit Output at maximum current R R 

0x020A Thermal Limit Thermal protection active R R 

0x020B DC Breaker Open DC breaker open R R 

0x020C Reverse Polarity Reverse polarity at output R R 

0x020D Positive Ground Positive ground fault R R 

0x020E Negative Ground Negative ground fault R R 

0x020F Battery Discharge Voltage below discharge threshold R R 

0x0210 Redundancy Check Charger will not support system load R R 

0x0211 OverVoltage 
Shutdown 

True = an over voltage condition has caused charger 
to shut down 

R R 

0x0212 Low Output Current True = Output current is below low current alarm 
setting 

R R 

0x0213 Battery Overtemp True = Temperature sensor indicates battery is over 
temp 

R R 

0x0214 Temp Sensor Fail True = Temperature sensor reading out of range. R R 

 
 

7.2 Boolean Read/Write Controls (Binary Outputs), Modbus Functions 0x01, 0x05, 0x0F 
  

Access  
Address Name Description Default 

USB Network 

SYSTEM CONTROLS (Addressed as BITS, read/write 8 bites per BYTE, lowest address is LSB of first byte. All 
chargers use the same settings) 

0x1000 Periodic Equalize Repeat timed equalize cycles at scheduled intervals Off R/W R/W 

0x1001 Periodic Battery 
Check  Invoke battery check at scheduled intervals  Off R/W R/W 

0x1002 Periodic 
Redundancy Test  Repeat both redundancy tests at scheduled intervals  Off R/W R/W 

0x1003 Temperature 
Compensation  Enable battery voltage temperature compensation  Off R/W R/W 

0x1004 Timed Equalize Perform single timed equalize cycle Off R/W R/W 

0x1005 Automatic Equalize  Automatic, time-limited equalize charge  Off R/W R/W 

0x1006 Float Mode Disables timed and automatic equalize charging  Off R/W R/W 

0x1007 Battery Check  
Perform a single timed battery check. Battery check 
begins on rising edge. Signal remains high for 
duration of battery check, automatically switches low 

Off R/W R/W 
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Access  
Address Name Description Default 

USB Network 
at end of timed check. Falling edge forces early 
termination. 

0x1008 Redundancy Check  Perform a single redundancy check Off R/W R/W 

0x1009 Demand Based 
Equalize  Perform a single equalize cycle Off R/W R/W 

 Internal Read-Write Control  

Access  
Address Name Description Scale 

USB Network 

0x1300 Network Access Allow/disallow network write access. Write access is 
through USB only 1 R/W R 

0x1301 Second Charger 
Installed 

True indicates to CommsGenius that a second charger 
is installed on the remote port 1 R/W R/W 

0x1302 Reset Network 
Connection 

True causes CommsGenius to reset the network board. 
Automatically reset to false after network board is 
reset. 

N/A W N/A 

0x1303 Save Settings  Writing a non-zero value saves all settings to non-
volatile memory N/A W W 

 
 
7.3 Numeric Read-Only Values, Modbus Function 0x04 
 

Access  
Address Name Description Scale USB Network 

SYSTEM VALUES 
0x2000 Equalize Timer Minutes remaining for this equalize cycle 100 R R 

0x2001 Battery Check 
Timer Seconds remaining for this battery check 1 R R 

0x2002 Redundancy 
Check Timer  Seconds remaining for this redundancy check  1 R R 

0x2003 
Remote 
Temperature 
Sensor  

Temp. comp. sensor reading, 235 = 23.5ºC 1 R R 

CHARGER 1 VALUES 

0x2100 Rated Output 
Voltage 12, 24, 48, 120, or 240 Vdc 1 R R 

0x2101 Rated Output 
Current 6, 12, 16, 25, 35, 50, 75, 100, or 150 Adc 1 R R 

0x2102 Output Voltage 1351 = 13.51Vdc 100 R R 

0x2103 Output Current 4950 = 49.50Adc 100 R R 

0x2104 Percent Input 
Voltage 101 = 101% of rated input voltage 100% R R 

0x2105 
Internal 
Temperature 
Sensor 

Temp. comp. sensor reading, 235 = 23.5ºC 10 R R 

0x2106 Heat Sink 
Temperature 850 = 85.0ºC 10 R R 

0x2107 Elapsed Time 
Months 

Elapsed time since charger power on: 
28 day "months" (0-1775), 1 R R 
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Access  
Address Name Description Scale USB Network 

0x2108 Elapsed Time 
Hours 1 R R 

0x2109 Elapsed Time 
Minutes 1 R R 

0x210A Elapsed Time 
Seconds 

hours (0-671), 
minutes (0-59), 
seconds (0-59) 

1 R R 

CHARGER 2 VALUES 

0x2200 Rated Output 
Voltage 12, 24, 48, 120, or 240 Vdc 1 R R 

0x2201 Rated Output 
Current 6, 12, 16, 25, 35, 50, 75, 100, or 150 Adc 1 R R 

0x2202 Output Voltage 1351 = 13.51Vdc 100 R R 

0x2203 Output Current 4950 = 49.50Adc 100 R R 

0x2204 Percent Input 
Voltage 101 = 101% of rated input voltage 100% R R 

0x2205 
Internal 
Temperature 
Sensor 

Temp. comp. sensor reading, 235 = 23.5ºC 10 R R 

0x2206 Heat Sink 
Temperature 850 = 85.0ºC 10 R R 

0x2207 Elapsed Time 
Months 1 R R 

0x2208 Elapsed Time 
Hours 1 R R 

0x2209 Elapsed Time 
Minutes 1 R R 

0x220A Elapsed Time 
Seconds 

Elapsed time since charger power on: 
28 day "months" (0-1775), 
hours (0-671), 
minutes (0-59), 
seconds (0-59) 

1 R R 

 
 
7.4 Read-Write Settings, Modbus Functions 0x03, 0x06, & 0x10 
 

Access  
Address Name Description Scale USB Network 

SYSTEM SETTINGS (all chargers use the same settings) 

0x3000 Float Setpoint 
per Cell Vdc per cell, 2220 = 2.220V/cell 1000 R/W R/W0 

0x3001 Equalize 
Setpoint per Cell Vdc per cell, 2350 = 2.350V/cell 1000 R/W R/W0 

0x3002 Equalize AC On 
Delay Minutes equalize inhibited after AC on 1 R/W R/W0 

0x3003 Equalize Time 
Limit Manual/automatic equalize time-out, hours 1 R/W R/W0 

0x3004 Equalize Time 
Interval Days between scheduled equalize cycles 1 R/W R/W0 

0x3005 
Volt per Cell 
Temp. 
Coefficient 

-mVdc/cell/ºC, 400 = -400mV/cell/ºC -100 R/W R/W0 

0x3006 Current Limit 
Percentage % Rated Adc, 105 = 105% 100% R/W R/W0 

0x3007 Low Current 
Alarm % Rated Adc, 25 = 25% 100% R/W R/W 

0x3008 High DC Alarm 
per Cell Vdc per cell, 2450 = 2.450V/cell 1000 R/W R/W 
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Access  
Address Name Description Scale USB Network 

0x3009 Over Voltage 
Shutdown Vdc per cell, 2450 = 2.450V/cell 1000 R/W R/W 

0x300A Batt. Disch. 
Alarm. per Cell Vdc per cell, 2050 = 2.050V/cell 1000 R/W R/W 

0x300B Low DC Alarm. 
per Cell Vdc per cell, 1850 = 1.850V/cell 1000 R/W R/W 

0x300C End Disch. 
Alarm per Cell Vdc per cell, 1750 = 1.750V/cell 1000 R/W R/W 

0x300D Ground Alarm 
Sensitivity Enum: 0-3 = disable/low/med/high leakage N/A R/W R/W 

0x300E Alarm Relay 
Delay Seconds delayed (except AC fail) 1 R/W R/W 

0x300F Battery Test 
Alarm per Cell Vdc per cell, 2000 = 2.000V/cell 1000 R/W R/W 

0x3010 Battery Check 
Duration Length of battery check, minutes 1 R/W R/W 

0x3011 Battery Check 
Interval Days between scheduled checks 1 R/W R/W 

0x3012 DC Bus 
Minimum Vdc per cell, 2000 = 2.000V/cell 1000 R/W R/W 

0x3013 Redundancy 
Check per Cell Vdc per cell, 2175 = 2.175V/cell 1000 R/W R/W 

0x3014 Redundancy 
Check Duration Length of Redundancy check, seconds 1 R/W R/W 

0x3015 Redundancy 
Check Interval Minutes between scheduled checks 1 R/W R/W 

0x3016 Cell Count Number of cells in battery string 1 R/W R 

0x3017 Cell Chemistry 0 = NiCd, 1 = VRLA, 2 = Flooded N/A R/W R 

SYSTEM REAL-TIME CLOCK 

0x3080 Real-Time 
Clock Second 1 R/W R/W 

0x3081 Real-Time 
Clock Minute 1 R/W R/W 

0x3082 Real-Time 
Clock Hour  1 R/W R/W 

0x3083 
Real-Time 
Clock Day of 
Week 

1 R/W R/W 

0x3084 Real-Time 
Clock Date 1 R/W R/W 

0x3085 Real-Time 
Clock Month 1 R/W R/W 

0x3086 Real-Time 
Clock Year 

Real-Time Clock Data: 
 
Second: 0-59, 
Minute: 0-59, 
Hour: 0-23, 
Day of Week: 1-7 = Sun-Sat, 
Date: 1-31 
Month: 1-12 = Jan-Dec, 
Year: 0-99 (starting at 0 = 2000) 

1 R/W R/W 

 
7.5 Communication Settings  

Communication settings can be changed only through the USB port. To prevent loss of network 
communications, these settings are read-only via the RS-485 and TCP/IP networks regardless of 
the network write-enable setting (see address 0x1300). 
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Address Name Description Scale 

0xF000 Network Protocol 

Enumerated: 
 
1 = serial Modbus ASCII 
2 = serial Modbus RTU 
3 = Modbus TCP/IP 
4 = serial DNP3 
5 = DNP3 TCP/IP 

1 

0xF001 RS-485 Parity Enumerated: 0 = none, 1 = odd, 2 = even (default) 1 

0xF002 RS-485 Data Rate 

Baud / 10 (typ. characters / second): 
11 = 110 Baud 
30 = 300 Baud 
60 = 600 Baud 
120 = 1200 Baud 
240 = 2400 Baud 
480 = 4800 Baud 
960 = 9600 Baud 
1440 = 14400 Baud 
1920 = 19200 Baud (default) 
2880 =  28800 Baud 
3840 =  38400 Baud 
5760 =  57600 Baud 
11520 = 115200 Baud 

0.1 

0xF003 RS-485 On/Off Delay Bus transceiver enable/disable delay (msec) 1 

0xF004 Number of data bits 7 or 8 1 

0xF005 Number of stop bits 1 or 2 1 

0xF010 tcpIpAddr3 1 

0xF011 tcpIpAddr2 1 

0xF012 tcpIpAddr1 1 

0xF013 tcpIpAddr0 

TCP/IP address: 64 bits, high order to low order [1] 

1 

0xF014 subNetMask3 1 

0xF015 subNetMask2 1 

0xF016 subNetMask1 1 

0xF017 subNetMask0 

TCP/IP subnet mask: 64 bits, high order to low order 
[1] 

1 

0xF018 networkGateway3 1 

0xF019 networkGateway2 

Gateway address: 64 bits, high order to low order [1] 

1 

                                                   
1 TCP/IP addresses are allocated four words (64 bits) to permit future migration to TCP/IP version 6. For 32 
bit addresses (TCP/IP version 4) the two low-order words are used, and the high-order words are ignored. The 
data is stored "Big-Endian", with the most significant byte first. 
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Address Name Description Scale 

0xF01A networkGateway1 1 

0xF01B networkGateway0 

 

1 

0xF01C networkTimeOut Network time-out parameter (msec) 1 

0xF030 Modbus Address Modbus serial interface address (1-247) 1 

0xF031 TCP/IP Port Port number for TCP/IP. Default = 502. 1 

 
 

7.6 Device Information Strings, Modbus Function 0x2B  
 

Address Name Description (All are ASCII text strings) Read Dev 
ID Codes 

0x01 Product Code Serial number text (eg, "123456") 1, 2, 3, 4 

0x02 MajorMinorRevision Communication board software revision (eg, "2.01") 1, 2, 3, 4 

0x05 Model Name CommsGenius model number 2, 3, 4 

0x80 CommsGenius Build Date eg, "Jul 1 2007" 3, 4 

0x90 Charger 1 Serial Number Serial number text (eg, "123456") 3, 4 

0x91 Charger 1 Software Rev. As shown on UI display (eg, "M1.02/C1.05") 3, 4 

0x92 Charger 1 Model Number eg, "Q024075TL514B" 3, 4 

0x93 Charger 1 Build Date eg, "Jul 1 2007" 3, 4 

0xA0 Charger 2 Serial Number Serial number text (eg, "123456") 3, 4 

0xA1 Charger 2 Software Rev. As shown on UI display (eg, "M1.02/C1.05") 3, 4 

0xA2 Charger 2 Model Number eg, "Q024075TL514B" 3, 4 

0xA3 Charger 2 Build Date eg, "Jul 1 2007" 3, 4 

 
 

7.7 IQ and CommsGenius Settings Limits 
  

Integer Data Values Charger Front Panel Display Values 
Battery Cell Type Battery Cell Type 

Parameter Scaling and 
Units Nickel-

Cadmium VRLA Flooded 
lead acid 

Nickel-
Cadmium VRLA Flooded 

lead acid 
10300 10300 10300 1.287 2.060 2.060 Battery Check Minimum 

DC Bus Voltage 

100 * % 
Nominal 
Voltage 9000 9000 9000 1.125 1.800 1.800 

14000 22000 22000 1.400 2.200 2.200 
End Discharge Alarm 10000 * V/Cell 

10000 17000 17000 1.000 1.700 1.700 
14000 22000 22000 1.400 2.200 2.200 Low DC Voltage Alarm 10000 * V/Cell 
10000 17000 17000 1.000 1.700 1.700 
14000 22000 22000 1.400 2.200 2.200 Battery on Discharge 

Alarm 10000 * V/Cell 
10000 17000 17000 1.000 1.700 1.700 
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16000 24500 24500 1.600 2.450 2.450 
Float Charge Voltage 10000 * V/Cell 

12000 20000 20000 1.200 2.000 2.000 
16000 24500 24500 1.600 2.450 2.450 

Equalize Charge Voltage 10000 * V/Cell 
12000 20000 20000 1.200 2.000 2.000 
17000 25000 25000 1.700 2.500 2.500 

High DC Voltage Alarm 10000 * V/Cell 
15000 22000 22000 1.500 2.200 2.200 
17500 26000 26000 1.750 2.600 2.600 

Overvoltage Shutdown 10000 * V/Cell 
15000 22000 22000 1.500 2.200 2.200 
180 180 180 180 180 180 Time Between Equalize 

Charge (Interval) 1 * Days 
1 1 1 1 1 1 

400 550 550 4.00 5.50 5.50 Temperature 
Compensation Slope 

-100 * 
mV/Cell/°C 75 100 100 0.75 1.00 1.00 

5 5 5 5 5 5 Demand-Based Equalize 
Time Delay (at power-

on) 
1 * Minutes 

0 0 0 0 0 0 

255 255 255 255 255 255 
Equalize Time Limit 1 * Hours 

1 1 1 1 1 1 
11000 11000 11000 110% 110% 110% 

Current Limit 100 * % Rated 
Current 3300 3300 3300 33% 33% 33% 

5100 5100 5100 Disabled Disabled Disabled 
5000 5000 5000 50% 50% 50% Low Current Alarm 100 * % Rated 

Current 
200 200 200 2% 2% 2% 
50 50 50 50 50 50 

Alarm Relay Delay 1 * Seconds 
5 5 5 5 5 5 

60 60 60 60 60 60 
Battery Check Interval 1 * Days 

1 1 1 1 1 1 
60 60 60 60 60 60 

Battery Check Duration 1 * Minutes 
1 1 1 1 1 1 
1 1 1 High High High 
2 2 2 Med Med Med 
3 3 3 Low Low Low 

Ground Fault Alarm 
Sensitivity Enumerated 

4 4 4 Off Off Off 

Battery Cell Type Enumerated 0 1 2 Nickel-
Cadmium VRLA Flooded 

lead acid 
10 6 6 10 6 6 

12V Models 
6 4 4 6 4 4 

20 12 12 20 12 12 
24V Models 

12 8 8 12 8 8 
40 24 24 40 24 24 

48V Models 
25 16 16 25 16 16 
96 60 60 96 60 60 

120V Models 
64 40 40 64 40 40 
192 120 120 192 120 120 

Battery Cell Count 

240V Models 
128 80 80 128 80 80 
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APPENDIX A: Modbus Address Reference by Function Type 
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APPENDIX B: IQ Charger Voltage Setting Interlocks 
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Notes for IQ Charger Adjustment Limits: 
 
• All settings have absolute minimums and maximums, shown by the heights of the five rectangular 

boxes. Those settings in each rectangular box share the same absolute limits. The absolute limits vary 
according to cell chemistry, as shown in the separate graphs for lead-acid and nickel-cadmium battery 
chemistries. 

• There also are relative limits between settings. Settings must be in this order: 

OV Shutdown ≥ HV Alarm 
HV Alarm ≥ (Equalize Charge + 2% Vnominal [2]) 

Equalize Charge ≥ Float Charge 
Float Charge ≥ (Battery Check Minimum DC Bus + 2% Vnominal [2]) 

Float Charge ≥ (Battery Discharging Alarm + 2% Vnominal [2]) 
Battery Discharging Alarm ≥ Low DC Alarm 

Low DC Alarm ≥ End of Discharge Alarm 

                                                   
2 Flooded lead-acid and valve-regulated lead-acid cells are 2.000V/cell nominal, so the 2% margins are 0.040V/cell 
for these types. Nickel-cadmium cells are 1.250V/cell nominal, so the 2% margins are 0.025V/cell for Nicad 
batteries. 
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• Periodic Equalize schedule: You may have up to two hours of Periodic Equalize per day of Equalize 
Interval: 

[Equalize Time Limit (hrs)] ≤  [2*Days Between Periodic Equalize (days)]  
 
• For enhanced product safety, the OV Shutdown setting can be changed only when the hardware "panel 

unlock" jumper is in the unlocked position. For normal operation, the jumper should be locked to 
prevent inadvertent changes to this important setting. 

• The charger's front panel changes one setting at a time. Adjustments beyond the absolute limits or 
relative limits are not accepted. Attempting to exceed the limits produces an audible warning beep. 

• The SENS IQ & CommsGenius Setup Utility checks all settings changes against absolute and relative 
limits before transferring them to CommsGenius. This ensures that charger settings will be acceptable 
before applying the changes. 

• Settings changes made via network connections will be checked when received by CommsGenius. 
Settings that are inconsistent with the absolute or relative limits will be rejected and not transferred to 
the IQ chargers. 

• If settings inconsistent with the absolute and relative limits described above are sent to the charger, the 
conflicts will be resolved as follows: 

1. If the new set of values does not satisfy the absolute and relative limits, CommsGenius will reject 
the adjustment command with a "data values" error. No changes will occur to any of the chargers' 
settings. 

2. If the hardware jumper is unlocked and the settings satisfy the absolute and relative limits 
described above, all setting changes will be applied to both chargers. 

3. If the hardware jumper is locked, the OV shutdown setting will not change.  This may require 
other settings changes to resolve conflicts: 

a. Apply the float charge setting. If it conflicts with the locked OV shutdown setting, reduce 
the float setting to resolve the conflict. 

b. Apply the equalize charge setting. If it conflicts with the locked OV shutdown setting, 
reduce the equalize setting to resolve the conflict. This may result in identical equalize and 
float settings, which is permissible. 

c. Apply the HV alarm setting. If it conflicts with the locked OV shutdown setting, reduce 
the HV alarm to resolve the conflict. This may result in identical HV alarm and OV 
shutdown settings, which is permissible. 

d. Apply the Battery Discharging, Low DC, and End of Discharge alarm settings in that 
order. In each case, if the setting conflicts with the adjusted float voltage setting or a 
previous alarm setting, adjust the alarm setting downward to resolve the conflict. This may 
result in some alarm settings being identical, which is permissible. 

e. Apply the battery check minimum DC bus setting. If it conflicts with the float charge 
setting, adjust minimum DC bus downward to resolve the conflict. 
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APPENDIX C: CommsGenius System Diagram 
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